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Brief Overview of ArcGIS 

ArcGIS is a software program, used to create, display and analyze geospatial data, developed by Environmental Systems Research Institute (ESRI) of Redlands, California. ArcGIS consists of three components: ArcMap, ArcCatalog and ArcToolbox. ArcMap is used for visualizing spatial data, performing spatial analysis, and creating maps to show the results of your work. ArcCatalog is used for browsing for maps and spatial data, exploring spatial data, and viewing and creating metadata. ArcToolbox is an interface for accessing the data conversion and analysis functions that come with ArcGIS. The ArcGIS software license comes in three variants: ArcView, ArcEditor, or ArcInfo, which are the low end, middle, and fully configured versions of the software. Any of these versions can be used for this exercise. The instructions in this exercise are illustrated using the tools in ArcGIS version 9.3.1, but version 9.3 will work fine as well.


Goals of the Exercise

This exercise introduces you to ArcMap and ArcCatalog. You use these applications to create a map of pan evaporation stations in Texas, and to draw a graph of monthly pan evaporation data measured at these stations. You use ArcCatalog to create a new personal geodatabase and import shapefiles to a feature dataset. The relationship between ArcGIS and MS Word and Excel is demonstrated so that you can create graphs in Excel, maps in ArcGIS and place the result in a Word file as a report for this homework. In this way, you link the spatial location of the observation sites, with the time variation of the water observations data at those sites.  


Computer and Data Requirements

To carry out this exercise, you need to have a computer, which runs ArcGIS.   
You will be working with the following spatial datasets during this exercise: 

1. A polygon shapefile of the counties of Texas, called Counties 

2. A point shapefile of pan evaporation stations, called Evap 

3. A polygon shapefile of the state of Texas, called Texas 

These shapefiles consist of several files (e.g. evap.dbf, evap.shp, evap.shx). You can get them from this zip file: http://www.ce.utexas.edu/prof/maidment/giswr2009/Ex1/Ex12009Data.zip 
You need to establish a working folder to do the exercise on. This can be in c:\temp, your student directory, or on a memory stick attached to the machine you are working on. To establish a new account at the CE Information Technology Support and Services, go to http://www.caee.utexas.edu/itss/ and select LRC User Accounts. If you don't yet have a regular Login account at the LRC, get a temporary guest login to do the exercise.   
After you have downloaded the zip file ex12008.zip double click on the file and you should see the Winzip, Alladin Stuffit utility, or other zip utility to open the file on your computer (if it doesn’t open you’ll have to unzip this file on a computer that has a zip utility installed). Extract all files from the zip file to the working folder that you’ve set up to do this exercise. You should end up with a file list that looks something like this. You may see these data within a sequence of folder names, and if so, click on each folder down through the sequence until you locate the required files.
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ArcGIS License Server

This exercise can be executed with any of the license levels within ArcGIS, namely ArcInfo, ArcEditor or ArcView. Each of these license levels provides access to ArcMap and ArcCatalog, which are the ArcGIS interfaces used to do the work. When you invoke ArcMap or ArcCatalog, it is possible that you will get a message saying that all the licenses for ArcInfo are in use on the network, or that you aren’t licensed for this application. In that event, you need to switch to another license level of the software with available licenses. To do this, from Windows use Start/Programs/ArcGIS to invoke the ArcGIS Desktop Administrator, and select another version. In the LRC, ArcView [Single Use] works best, but in another lab setting, the ArcView [floating] or ArcEditor [floating] could be the right choice, depending on license availability.
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Procedure

Please note that the following procedure is a general outline, which can be followed to complete this lesson. However, you are encouraged to experiment with the program and to be creative. 

1. Viewing Shapefiles 

A shapefile is a homogenous collection of simple features that do not contain topological information. The format was introduced with ArcView 2.0 to simplify the representation of spatial data. A shapefile includes geometric features and their attributes. The attributes are contained in a dBase table, which allows for the joining with a feature based on the attribute key.

Viewing Shapefiles in ArcMap

(1) Open ArcMap and select the A new empty map option.
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(2) Use the [image: image5.png]


(Add Data) button to add the exercise data for this exercise. Navigate to the folder, which contains the data, and select all three files at once by using the shift key. Click the Add button to import the data. If you are using a network drive to obtain your files use the [image: image6.png]


 button to add the network drive to the ones that ArcMap is accessing so you can get to the files.
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In ArcMap, a layer consists of a reference to a spatial dataset (such as a feature class, shapefile or coverage) and a definition of how to display it (legend colors, line thickness, etc.), and a map is a graphical representation of geographic information. The left panel in the ArcMap window is the Table of contents, and the right panel is the Display window. In the middle is ArcToolbox, whose use we will cover later. Click this off so that you just have the Table of Contents and the Map Display panels displayed. The Table of contents lists layers, and the Display window displays maps. As you can see it is very simple to add shapefiles to ArcMap.

(3) Click off the check marks next to the layer names in the left hand column. Click on the check box next to each layer name individually to view what features that layer contains.   You can drag the layers up and down in the layer display to alter the order in which they are viewed on the map.  Place the counties layer above the Texas layer so that you can see the county outlines.
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When you are done exploring the possibilities of ArcMap, exit the program. You do not need to save the file since you will be coming back to ArcMap later in the exercise.
Preview Shapefiles in ArcCatalog 

(4) Open ArcCatalog 
Arc Catalog is like a Windows Explorer for GIS files. It helps you to quickly explore what data you have.
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(5) On the left panel, search for the folder where the exercise data is located. 
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In ArcCatalog, you can toggle the right panel display between a file tree (Contents tab), a data view (Preview tab), and a metadata document (Metadata tab). 

(6) Highlight the layer for the Counties shapefile and click on the Preview tab in the right panel. First look at the Geography preview.
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You can see the layer represents the outline of Texas. The Preview option allows you to display the feature class table as well, by selecting Table instead of geography at the bottom of the panel. 
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If you click on the Metadata tab, you’ll see descriptive information about the Counties layer:
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Click on the other two data layers to preview them also.
2. Creating Geodatabases, Feature Datasets, and Feature Classes

A geodatabase is a relational database that stores geographic information. A relational database is a collection of tables logically associated with each other by common key attribute fields. A geodatabase can store geographic information because, besides storing a number or a string in an attribute field, tables in a geodatabase can also store geometric coordinates to define the shape and location of points, lines or polygons. Note that a single table can store only one type of spatial feature (point, line or polygon) and not a mixture of feature types. A personal geodatabase is a file with extension .mdb, which is the file extension used by Microsoft Access. 
A feature dataset is a collection of feature classes that share the same spatial reference. The spatial reference describes both the projection and spatial domain extent for a feature class in the geodatabase. Because the feature classes in a feature dataset share the same spatial reference, they can participate in topological relationships with each other such as in a geometric network. These topological relationships can also be stored in the feature dataset. Note that feature classes in a geodatabase can exist as stand-alone feature classes, without being part of any feature dataset.

A feature class is a collection of features with similar geometry. There are point, line, and polygon feature classes. Two types of feature classes exist: simple feature classes and topological feature classes. A simple feature class includes features that have no topological associations among them and features maybe edited independently of each other. Topological feature classes are bond as one integrated topological unit, such as a geometric network that we’ll explore later in this class.

Create a new Geodatabase 

(1) To create a new geodatabase in Arc Catalog first right click on the folder that contains the data for the exercise. Select New/Personal Geodatabase and a new geodatabase -- called New Personal Geodatabase.mdb and represented by an icon with the shape of a cylinder -- will be created. Note – a File Geodatabase is an alternative form that stores the data in a file system instead of as an Access file. It can be faster to do this but this is not important for this exercise.
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(2) Name the geodatabase Ex1Data (the geodatabase will keep its file extension mdb regardless of whether you included it in the name or not). You can right click on the geodatabase name and use Rename to rename the file.
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Adding Data to the Geodatabase 

When first loading data into a geodatabase, it is important to think about the data and how they are related. As mentioned above, in geodatabases the data is placed in feature classes that are then organized into feature datasets. A geodatabase can have one or more feature datasets. Each feature dataset has a single reference frame, which includes the map projection and map extent. It is possible to define the reference frame after the creation of the feature dataset and before data is loaded. 
Create a New Feature Dataset

We will create a new feature dataset within this geodatabase to define the spatial reference of our data. Right click on the Ex1Data.mdb geodatabase and select New Feature Dataset.
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Name the new feature dataset Texas, and hit Next to set the co
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and hit Next to set the coordinate system for these data.
Select [image: image18.png]Import.



 in this screen, and then select Texas.shp. 
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This has the effect of assigning the coordinate system of the Texas.shp theme to the Feature Dataset. 
[image: image20.png]rdinate System

Lookin [ dus

evap.shp
countiesshp
Bexinatamds




Click Add and then Next and you will be asked to select a vertical coordinate system
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In this case, we don’t have vertical coordinates (z-values) so we’ll just accept “none” and hit Next. You’ll now be asked to select tolerances for various coordinate systems. Just “accept the default resolution” and hit Finish. Note that this process of setting up a Feature Dataset in ArcGIS version 9.3 and 9.3.1 is significantly different than in earlier versions of ArcGIS and this avoids a problem of your being forced to set a spatial bound on the extent of your data that caused considerable difficulties in this class in previous years.
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Now you have a new feature dataset called Texas.  Don’t worry if you see a screen that says that Metadata has not been set for the selected item.
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And if you view the Spatial component of the Metadata for this Texas feature dataset, you’ll see that you are using NAD_1983_Albers projected coordinate system. 
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And if you click on details, you’ll see some more information about the parameters of this coordinate system. You’ll learn what this means in your lecture on map projections and coordinate systems!
[image: image25.png]Details
Map Projection Name: albers Conical Equal Area

Standard Parallel; 27.416667
Standard Parallel; 34.916667
Longitude of Central Meridian: -100,000000
Latitude of Projection Origin: 31.166667
False Easting: 1000000,000000
False Northing: 1000000,000000

Planar Goordinate Information
Planar distance Units: meters
Coordinate Encoding Method: coordinate pair
Goordinate Representation
Abscissa Resolution; 0000100
Ordinate Resolution: 0000100

Geodetic Model
Horizontal Daturn Narme: North American Datum of
1983
Elipsoid Narne: Geadetic Reference System 80
Sermi-major Axis: 6378137,000000
Denominator of Flattening Ratio: 298.257222




If you check the file list for the shape files that you opened at the beginning of this exercise, you’ll find that all the shape files have a .prj file which describes their geospatial coordinate system.
[image: image26.png]“Jcounties

5 countes.chp
= countes.shp
) counties.shx.
B
Bevapen
Fevap.she
= evap.shp
[Fevap.shx
[ Texas
B Texss.pr |
3 Texas sbn
[ Texas.sbx
= Texas.shp
[ Texas.shx

13KB
1Ke
%478
58
Er
2k8
1Ke
218
1Ke
1Ke
1Ke
1Ke
1Ke
1Ke
162k8
1Ke

DEF File
PRIFlE.
SHP e
XML Document
SHeFle
DEF Fie
PRIFlE.
SHP e
XML Document
SHeFle
DEF Fie
PRIFlE.
L
SEX File
SHP Fle
SH¢Fle




If you open the Texas.prj file in MS Word, you’ll see the following information:

PROJCS["NAD_1983_Albers",GEOGCS["GCS_North_American_1983",DATUM["D_North_American_1983",SPHEROID["GRS_1980",6378137.0,298.257222101]],PRIMEM["Greenwich",0.0],UNIT["Degree",0.0174532925199433]],PROJECTION["Albers"],PARAMETER["False_Easting",1000000.0],PARAMETER["False_Northing",1000000.0],PARAMETER["Central_Meridian",-100.0],PARAMETER["Standard_Parallel_1",27.41666666666667],PARAMETER["Standard_Parallel_2",34.91666666666666],PARAMETER["Latitude_Of_Origin",31.16666666666667],UNIT["Meter",1.0]]

This information is what has been displayed in a more readable form in the metadata file that you’ve just looked at in ArcGIS.  Notice also in the list of files given below that you now have two Microsoft Access files in this list called Ex1Data, one which has 536KB and actually contains the data, and the other which is 1KB which is a “lock file” [image: image27.png]FEx1Data



 that exists while the ArcCatalog or ArcMap applications are open to prevent this file from being altered with another application while you are working on it in ArcGIS.
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It happens that all these shape files have the same coordinate system as the Texas shape file so when they are imported into the geodatabase, they overlay correctly in the same spatial reference. If you get shape files or coverages with undocumented coordinate systems, it can be a real headache to figure out what the correct coordinate system is. Fortunately, ArcGIS version 9 automatically documents the coordinate system on each shape file, but earlier versions of ArcView did not do this, and you may encounter the problem of undocumented coordinate systems when loading older shape file data.

To import the shape files into the feature dataset, right click on the Texas feature dataset and select Import Feature Class (single)
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You’ll see a Green Dot next to Input Features – browse for the shapefile Texas and click to import it. Type the name Texas into the Output Feature Class Name field: 
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Click Ok and a new feature dataset called Texas will be created within the Ex1Data geodatabase, and within that a new feature class called Texas will exist which contains the outline of the state of Texas.
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And if you view the Geography of this feature class in Arc Catalog, you’ll see:
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Ok, let’s continue with the exercise.

Import the other shape files for Counties and Evaporation to the feature dataset in a similar way that you just did for the Texas outline. You may see some messages in Green about the resolution of the output feature class being greater than for the input feature class. Don’t worry about this.
After creating the geodatabase, the feature dataset and the feature classes, the ArcCatalog tree looks like this: 
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Note that the feature classes Texas, Counties, and Evap could have been created outside the feature dataset Texas, but since they share the same coordinate system, it was decided to group them together within the feature dataset.   If you have data in other coordinate systems (defined with a .prj file) these will be automatically converted to the coordinate system of the feature dataset during the importing process.
3. Displaying Feature Datasets in a Map

We will now add the feature dataset that we created in ArcCatalog to an ArcMap document. 
(1) Close Arc Catalog.  If you look in Windows Explorer at this folder, you’ll see that the lock file has now gone away.   

You can display data in ArcMap when ArcCatalog is open on the same data, but you cannot alter these data in any way.  

To display the spatial data of the Texas feature dataset in a map, now open ArcMap.  You can launch ArcMap from within ArcCatalog using  [image: image35.png]


 or you can open ArcMap from the Start menu as you did before. 
(2) In ArcMap, click on the Add Data button, [image: image36.png]


. 
Browse to the feature dataset Texas, 
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and click Add. This has the effect of adding all the feature classes in the feature dataset to the ArcMap display. You can add individual feature classes within the Texas feature dataset if you so desire, by clicking on the feature dataset icon, and then on the icons of one or more of the feature classes (Hold down Ctrl or Shift to select more than one feature class). 

Note that the Table of Contents lists the layers corresponding to the three feature classes of the Texas feature dataset that you just added, while the Display window displays the map with the corresponding spatial data (i.e., Texas counties and evaporation stations). When I loaded up my feature dataset, I found that the Texas outline map is plotted above my Counties so I can’t see my County boundaries. 
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This is fixed by dragging the Counties feature class up in the list of Layers so that it is above the Texas layer. The order in which the feature classes are displayed is the order they are listed in the Layers.
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(3) Save your work in ArcMap by choosing File/Save and, after navigating to your working directory, naming the file Ex1 (the file will be assigned the extension mxd). When you do this, the Ex1.mxd file contains the file location of the geodatabase and the symbology you’ve chosen for the map display. You can shut down Arc Map and then invoke Arc Map again and reload the same map display by clicking on Ex1.mxd. Note, however, that if in the mean time you’ve relocated your geodatabase, ArcMap will go back to where you had it at the time the map file was saved. 
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________________________________________________________________________
Helpful Tip:

If you open your ArcMap Ex1.mxd file later from another location in your file system, you may see a red exclamation points beside your feature classes. If this happens, in ArcMap, right click on the feature class use Data/Set Data Sources to relocate the file location where the corresponding data are now stored and your map will display correctly again. It does not matter where the Ex1.mxd file is stored, you can move that around wherever you want, but it does matter where the data referred to in that file are stored. ArcGIS 9.3 is a good deal cleverer at dealing with file locations than earlier versions were so you may not encounter this problem.
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Ok, let’s continue on with the exercise.

(4) To change the appearance of a map display, you can access the Symbology menu just by double clicking on the Symbol
 [image: image42.png]



displayed in the ArcMap Layers, and you’ll get the Symbol Selector window 
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Click on the symbol color box, make your selections for the Fill Color and the Outline Color, and click OK, twice. Follow this procedure to modify the display of the Counties layer. Hopefully, the new map looks better than the original one. You can show the outline of the State of Texas more distinctly by using the Hollow symbology for the Texas polygon and then changing the Outline Width to 2 or 3. Otherwise the Texas layer is obscured behind the Counties layer and you won’t see it.

More complicated symbol shading that has the color and size of the symbols varying according to attributes of a feature class can be manipulated by accessing the Properties of the Symbology of the Feature Class.
To Save this map display, use File/Save As in ArcMap and save the resulting file as Ex1.mxd.
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4. Using Base Maps from ArcGIS Online
Up to this point we have just used local GIS data in our display.   Lets instead using base maps from the ArcGIS Online.  User File/Add Data From ArcGIS Online:
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and you’ll see a web page pop up that looks like:
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(All the .LYR files presented on the page below can be found on the new ArcGIS Online website and we will event.
website instead to access these fies).
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Click on “World Street Map”, the second map from the left on the top row of maps.  Click Ok on the screen “Opening World_Street_Map.lyr” 
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You’ll see a background map appear behind your Texas display:
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Click on the Counties theme and use the Symbol Selector to make the theme “Hollow” so we can see through it to the background map, and the new display appears as:

[image: image49.png]



Zoom in to Travis County by Austin in the center of Texas, and lets examine the evaporation site by Lake Travis to the Northwest of the city:

[image: image50.png]



Lets label the sites with their names.  Right click on the Evap theme and select Properties at the bottom of the display that appears.   Select the Labels tab and for the Label Field, select STAT_NAME, and 16 point as the type size.  Hit Apply and then Ok, to close this window.
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Now, right click on the Evap theme again and select Label Features, and you’ll see a nice label Mansfield Dam appear by the site next to Lake Travis.
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If you zoom in a bit closer, you can see just where the site is located near Lake Travis.  Mansfield Dam is the dam that is at the downstream end of Lake Travis.
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Now, lets look at some imagery for this location.  Proceeding as you did before to get the World Street Map, use File/Add Data from ArcGIS Online, to add data for World Imagery 
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And now you’ll see the same information displayed against a background map of orthoimagery:

[image: image56.png]



Pretty cool!!

And lets zoom in a bit to see more detail:
[image: image57.png]



I used the Evap Properties to change the Label color from Black to Yellow to make it show up better against the dark background of the orthoimagery.

Ok, this is pretty cool!  You can see how you can use standard road base maps to locate your area of interest, and imagery to understand the context of a site. This is the first time in ArcGIS that we’ve really been able to do this kind of thing, which was popularized in the GIS field by Google Earth and Microsoft Virtual Earth.

Use File/Save As to save this new map display as Ex1BaseMap.mxd so that you can get it back later if you need it.


5. Accessing and Querying Attribute Data
Numerical and text information stored in the fields of the geodatabase tables are called attributes. To access attribute data of the feature classes at a specific location:
(1) In ArcMap use File/Open, to open your previously saved Ex1.mxd from Section 3 of this exercise. 
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Click on the Identify Features tool [image: image59.png]


 which is contained within the “Tools” menu. If you don’t see this set of tools on your ArcMap document, use View/Toolbars and click on Tools to make it appear.
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This is the toolbar you need.
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(2) Click on the feature on the map you are interested in, and in the Identify Results window, select the object you are interested in. In the figure, attribute data for the Austin Airport evaporation station in Travis County has been retrieved (Travis County is where Austin and the University of Texas are located). I have used the Zoom button [image: image62.png]


 to zoom into the middle of the state where Travis County is located to create the next picture:
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If you inadvertently close the Tools menu you just used, you can open it again from the View 

Viewing an Attribute Table 

(3) Tables that contain attribute data of a layer are always called Attributes of <layer name>, and contain a field called Shape. The field Shape displays the words Point, Line or Polygon, but it really stores a geometric object with the shape of a point, line or polygon. To access attribute data of an entire layer, in ArcMap: right click on the Evap layer name in the table of contents, and select Open Attribute Table: 
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And if you scroll down and click on ObjectID 44 you’ll see the record that contains the attributes of the Austin Airport station that you identified earlier. Click on this to select it, and you’ll see the corresponding point selected in the map – this is a key idea of GIS – map features are described by records in attribute tables.   These are data measured by the Weather Service Office (WSO) at the Austin Airport (AP).
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 (4) To Clear a Selected feature and select a new one, use: Selection/Clear Selected Features in the ArcMap toolbar: 
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6. Selecting features from a feature class (points, lines and polygons)

Selecting features from a feature class involves choosing a subset of all the features in the class for a specific purpose. Feature selection can be made from a map by identifying the geometric shape or from an attribute table by identifying the record. Regardless of how you select an object, both the shape in the map and the record in the attribute table will be selected. To choose a particular data layer for selection use Selection/Set Selectable Layers and then click off the layers that you don’t want to have selected. Be careful when using this Set Selectable Layers function because if you later want to select features from another class, you’ll have to go back and change this selection to your new class.
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(1) To select an object from the map, in ArcMap: click on the Select Features tool [image: image69.png]


, in the Tools menu

(2) Zoom to the full extent of the map, by using the [image: image70.png]


 button on the Tools menu. Click on the Counties polygons you want to select. To select more than one object, press the Shift key and hold it down while you click on the additional objects. Selected objects are displayed with a light blue outline, although the color might change depending on your settings. The corresponding attribute table records have also been selected. You can verify this by opening the Counties attribute table, and hit Selected at the bottom of the attribute table to show just the Selected Counties.
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(3) To clear your selection, right click on the layer name, and choose Selection/Clear Selected Features. 

7. Making a Chart

Charts are useful because they allow you to visualize trends in data. ArcMap has chart-making capabilities. We will plot a chart of one or more records selected from a geodatabase table. 

(1) Use Selection/Set Selectable layers to show only the Evap data layer. 
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Select the two evaporation points that are located in Travis County. Travis County is located in Central Texas and has a characteristic shape like a tooth! If you open the Evap attributes table and hit [image: image73.png]Selected



 you’ll see just the evaporation records for these two stations (one at the airport, and one at Mansfield dam which creates Lake Travis, a large lake near Austin). If you scroll across, you’ll see some attributes from January to December and an Annual value. These are monthly and annual average pan evaporation values in inches compiled from historical data measured at these locations.  Right click on Options at the bottom of the Attribute Table and select Create Graph.
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You can also get at this Chart menu from the ArcMap tools menu as shown below:
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(2) You will be making a Vertical bar chart (the default option). The next screen will allow you to indicate the data to be used in the graph. Here is a graph of the Annual Evaporation (Ann_Val) of the two stations plotted against a backdrop of all the stations in Texas, indexed using ObjectID:
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Hit Next and edit the graph properties to make them nicer.  Click off  [image: image77.png]¥ addta legend



 to get rid of the legend on the right hand side.   Use [image: image78.png]Color



 to customize the color display of your data.
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Hit Next to Customize the Graph Title and Axis titles on the graph.
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Press Finish. You have created a graph in ArcMap!!

Save your ArcMap document Ex1.mxd so that you can retain this display.

Another graphing option is to make a chart in Excel using the dBase tables given by the evaporation shapefile. Open the evaporation attributes table evap.dbf as a table in Excel. Use Files of Type: dBase files in Excel to focus only on .dbf tables when you open the table. Select the stations you want to plot, copy their records to a new worksheet, delete the columns you don't need there, and then create a chart. Here is an example chart created this way. The column headers have been renamed from Jan_Val to Jan, etc to make the Chart x-axis more attractive to view. The legend has been moved to the top of the chart to allow a wider spacing of the data in the chart. I copied the data for Mansfield Dam and Austin airport into a new spreadsheet to make this chart.
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____________________________________________________________________________ 

Helpful Tip:

Instead of opening the evap.dbf file in Excel, you could have accessed the same data directly from the geodatabase using Data/Get External Data in Excel
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Choose MS Access Database as the data source. 
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Navigate to the geodatabase and select the table Evap. Then select the fields that you want to appear in the spreadsheet. You’ll end up with a spreadsheet containing the data for all the fields you’ve selected.
Ok, let’s continue with the exercise.

8. Creating a Map Layout

To consolidate a map of counties of Texas with evaporation stations with the graph that you created before in a single sheet of paper, in ArcMap: (1) change the format of the display window from Data View to Layout View by clicking on View/Layout View, 
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If your Layout doesn’t display properly in ArcMap, hit [image: image85.png]2n ]



 at the bottom of the map display to refresh it.
Reduce the size of the data frame in the layout (i.e., rectangle where the spatial data is contained) -- to make room for the graph -- by clicking on the graph and moving its handlers. If you have a zoomed in view in Arc Map, you’ll get the same image in in the Layout. To go back to the image of the whole State of Texas, right click on the Texas data layer in the legend and select Zoom to Layer. 
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To insert the ArcMap Chart into the Layout, right-click on the upper blue bar at the top of the Chart and select Add to Layout. Move and resize the graph as necessary. If you want to copy your graph from Excel, highlight the graph, and click on Copy on Excel, then Paste in ArcMap and your graph should appear in the map layout.
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You can draw lines to relate the location of the measurement stations and the data plotted on the graph using the Draw a Line tool from the ArcMap Draw toolbar (to display this Toolbar, use View/Toolbars and select Draw). This draw toolbar works the same in ArcMap as it does in other MS applications. It is important to show some association between the data plotted on the chart and where these data were measured on the map so that you can figure out which data series was measured at what location. 
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Or you can add text with the text tool [image: image90.png]


shown next to the line draw tool. The text displays in very small font sizes.  Select and click on them, and use Properties to resize them.  You can also insert a North Arrow and a Scale Bar by using the Insert menu in ArcMap.   
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When you put up the scale bar it is in meters because those are the map units used in the data.  If you click on the scale bar you can redefine the distance units (I have used miles) and if you expand or contract the scale bar you can show a desired spacing of these distance units.

Your map might look like this:
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You can export your map from ArcGIS using File/Export Map from the ArcMap menu, and you can store this as Ex1.emf in your data file. Then you can add it to a Word document using Insert/Picture/From File and load this emf file, as shown below. Pretty cool!
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Then you can add it to a Word document using Insert/Picture/From File and load this emf file, as shown below. Pretty cool!
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Here's another option: suppose you want to take a chart in Excel and add a map to the Chart to show where the data apply.   In the Map display (not Layout Display) use File/Export Map to create another .emf file, and then in Excel you can use Insert/Picture from File to place this in an Excel graph.  You can see that in this map, a nice color association between the symbols on the map and the bars on the chart makes it clear which data series was measured at which location. This chart shows a different pair of evaporation stations that are color code at their geographic locations so you can see how the pattern of evaporation varies geographically.
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The manipulations just described transfer objects from one application to another. 
___________________________________________________________________________

Helpful Tip:

A more general procedure is to simply copy the screen to the clipboard and crop out the part that you want, saving it to a file for later use. That is how all the images in this exercise were prepared. To copy any image, hit Print Screen on your keyboard (this copies the Screen onto the Clipboard). If you only want to capture the active frame, press Alt + Print Screen. This is convenient if you only want to capture an attribute table or graph within ArcMap as opposed to the entire screen, therefore no cropping is necessary.
The image copied from the screen can be pasted directly into word then edited using the Format tab. Double click the pasted image to automatically open the Format tab. The Crop function allows you to trim out the unwanted portions of the image.
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‘The manipulations just described transfer objects from one application to another.

Helpful Tip:

A more general procedure is to simply copy the sereen to the clipboard and crop out the part that you want, saving it to a file for later use. That is how all the images in this exercise were
‘prepared. To copy any image, hit Print Screen on your keyboard (this copies the Screen onto the Clipboard). If you only want to capture the active frame, press Alf + Print Screen. This is
convenient if you only want to capture an attribute table or graph within ArcMap as opposed to the entire screen, therefore no cropping is necessary.

The image copied from the screen can be pasted directly into word then edited using the Format tab.

Ok, let's continue with the exercise.
To be turned in: An ArcMap map layout in it showing a map of Texas with gages, and linked with a graph showing monihly evaporation data plotted from one or two gages.
8. Learn about Google Earth

An addendum to this exercise that explores the how to use the same data as in this exercise in the context of Google Earth is available at
http://www.ce.utexas.edu/prof/maidment/giswr2006/Ex1/Ex12006Google.doc

These materials may be used for research and educational purposes only. Please credit the authors and the
Center for Research in Water Resources at The University of Texas at Austin.
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___________________________________________________________________________

Ok, let’s complete the exercise:
To be turned in: An ArcMap map layout in it showing a map of Texas with gages, and linked with a graph showing monthly evaporation data plotted from two gages.  In the presentation of information on maps and charts it is important to include sufficient labeling detail so that the information can be clearly and unambiguously interpreted.  You should include a scale bar to indicate distance, a north arrow to indicate direction and labels or legends with units wherever they are needed to interpret map or quantitative values.  

Lets see some nice cartography!!
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